
Part - I
Note: 	(i)	 Answer all the questions. � (15 × 1 = 15)
	 (ii)	�Choose the most appropriate answer from the 

given four alternatives and write the option code 
and the corresponding answer. 

1.	 Expansion of POST is : 
(a)	 Post on Self Test	 (b)	 Power on Self Text
(c)	 Power on Self Test	 (d)	 Power on Serial Test

2.	 (1110)2 - the equivalent hexadecimal is :
(a)	 F	 (b)	 D	 (c)	 E	 (d)	 B

3.	 The shortcut keys used to rename a file in Windows:

(a)	 F4 	 (b)	 F2	 (c)	 F5	 (d)	 F6

4.	 What is the shortcut key to go to the beginning of 
the line?
(a)	 Home			   (b)	 End
(c)	 Ctrl + Home	 (d)	 Ctrl + End

5.	 The key used to move the cell pointer in the forward 
direction within the worksheet is :

(a)	 Enter 			   (b)	 Tab

(c)	 Shift + Tab		  (d)	 Delete

6.	 The conditional statement used to transfer control 
from current statement to another statement.
(a)	 Branching	 (b)	 Sequencing
(c)	 Looping	 (d)	 Interating

7.	 Hotspot uses which type of Network Services?
(a)	 LAN			   (b)	 PAN
(c)	 WLAN			   (d)	 WAN

8.	 How many levels of heading tags available in HTML? 
(a)	 4	 (b)	 6	 (c)	 8	 (d)	 3

9.	 Which of the following tags are called as ‘physical 
style’ tags?
(a)	 <html>, <b>, <br>	 (b)	 <b>, <br>, <u>
(c)	 <b>, <A>, <i>	 (d)	 <b>, <i>, <u>

10.	 The important attributes used with the <form> tag 
are :
(a)	 name and size	 (b)	 type and name
(c)	 method and action	 (d)	 post and set

11.	 Which of the following indicates that the text included 
is a commnet in CSS style sheet?
(a)	 /*....*/			   (b)	 !*....*!
(c)	 <*....*>			  (d)	 \*....*\

12.	 Which of the following is not a looping statement?
(a)	 Switch			   (b)	 While

(c)	 Do-while		  (d)	 For

13.	 In the below snippet,
Value of x is, 
Var x = 102+5 – 50;
(a)	 57	 (b)	 47	 (c)	 50	 (d)	 52

14.	 Which one of the following tracks a user visits a 
website?
(a)	 Trojan			   (b)	 Worms
(c)	 Cookies			  (d)	 Spyware

15.	 Library functions are aslo called as _______.
(a)	 Commands		  (b)	 Storage functions
(c)	 Instructions		 (d)	 Predefined functions

Part - II

Note	: 	 �Answer any six questions. Question No. 24 is  
Compulsory.� (6 × 2 = 12)

16.	 What are the components of a CPU?
17.	 What is known as Multitasking?
18.	 In OpenOffice Writer, how do you merge cells in a 

table?
19.	 Write about the text operator in OpenOffice Calc.
20.	 How do you define comments in HTML?

Instructions : 	 1. �	� Check the question paper for fairness of printing. If there is any lack of fairness, inform the Hall 
Supervisor immediately.

			   2. 	Use Blue or Black ink to write and underline and pencil to draw diagrams.
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21.	 What is the use of <style> tag?
22.	 What is a function in JavaScript?
23.	 List the Search Engines supported by Tamil Language.
24.	 Convert (1560)8 into equivalent decimal number.

Part - III 

Note	: 	 �Answer any six questions. Question No. 33 is 
Compulsory.� (6 × 3 = 18)

25.	 Write down the interfaces and ports available in a 
computer.

26.	 Write a short note on multi-processing.
27.	 In OpenOffice Impress, what is a Normal View?
28.	� What are the advantages of Email?
29.	 Briefly explain the attributes of <hr> tag.
30.	 Explain the values of <input> tag’s type attribute.
31.	 Write a note on basic data types in JavaScript.
32.	 Differentiate between while and do..while statements.
33.	 What is Indenting Text in Writer? Write its types.

Part - IV
Note : Answer all the questions. � (5 × 5 = 25)

34.	 (a)	 Explain the following :
		  (i)	 Inkjet printer
		  (ii)	 Multimedia projector
		  (iii)	 Bar code / QR Code Reader

(OR)
	 (b)	 Explain the characteristics of a Microprocessor.
35.	 (a)	 Write the procedure to Find and Replace a Word 

with another Word in OpenOffice Writer.
(OR)

		  (b)	 (i) 	 Convert (58.36)10 to Binary.
		  (ii)	� Find 1’s complement and 2’s complement 

for the decimal number (–55)10.
36.	 (a)	 Write in detail about the pop-up dialogue boxes 

in JavaScript.
(OR)

	 (b)	 Write down the rules for naming variables in 
JavaScript.

37.	 (a)	 Write the steps to generate the following series.
		  5, 10, 20, ........... 2560

(OR)
	 (b)	 Explain filters in OpenOffice Calc.

38.	 (a)	 What are the different methods to change the 
margin in writer?

(OR)

	 (b)	 Explain the different types of cyber attacks.

Answers
 Part - I

1.	 (c)	 Power on Self Test	 2.	 (c)	 E
3.	 (b)	 F2	 4.	 (a)	 Home
5.	 (b)	 Tab	 6.	 (a)	 Branching
7.	 (c)	 WLAN	 8.	 (b)	 6
9.	 (d)	 <b>, <i>, <u>
10.	 (c)	 method and action
11.	 (a)	 /*....*/	 12.	(a)	 Switch
13.	 (a)	 57	 14.	(c)	 Cookies
15.	 (d)	 Predefined functions

Part - II
16.	 The CPU has three components which are Control 

unit, Arithmetic and Logic Unit (ALU) and Memory 
unit.

17.	 Microsoft windows is one of the most popular graphical 
user Interface. Multiple applications can execute 
simultaneously in windows, and this is known as 
‘Multitasking’.

18.	 To merge cells in a table:
	 (i)	 Select the cells to merge.
	 (ii)	 �Right click and choose Cell → Merge or Choose 

Table → Merge Cells from the menu bar.

19.	 In Calc, “&” is a text operator which is used to combine 
two or more text. Joining two different texts is also 
known as “Text Concatenation”. An expression using 
the text operator has the following 

	 syntax: text reference1 & text reference2.

20.	 The tag <!> is used to create comments. In HTML, 
the text what you type within this tag is considered as 
comments and it is ignored by the browser. Comments 
never show up onscreen. Comments can be placed 
anywhere in HTML document.

	 The general form of comments: <! comments >
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21.	 A style tag is used to change the default characteristics 
of a particular tag in the entire web document wherever 
that tag is used. The <style> tag controls the presentation 
styles of a particular HTML document. If you want 
to use a particular tag with the same style applied in 
one HTML document to another is not possible.

	 Thus, the <style> tags are called as “Page-Level Styles” 
or “Internal Style Sheets”.

22.	 A function is a block of JavaScript code that is defined 
once but may be executed or  invoked any number of 
times.

23.	 Search Engines supported by Tamil Language are:
	 (i)	 Google	 (ii)	 Bing
	 (iii)	 yahoo

24.	

Weight 512 64 8 1
Positional 
notation 83 82 81 80

Given  
number 1 5 6 0

(1560)8 	=  512 × 1 + 64 × 5 + 8 × 6 + 1 × 0

	 = 512 + 320 + 48 + 0

(1560)8  =  (880)10

Part - III
25. 	 Interfaces and ports available in a computer :
	 (i)	 Serial Port	 (ii)	 Parallen Port
	 (iii) 	 USB 3.0	 (iv) 	 VGA Connector
	 (v) 	 Audio Plugs 	 (vi) 	 PS/2 Port
	 (vii) 	 SCSI Port
	 (viii)	 High Definition Multimedia Interface (HDMI).

26.	 (i)	� Multi-processing is a one of the features of 
Operating System.

	 (ii) 	� It has two or more processors for a single running 
process (job). 

	 (iii) 	� Processing takes place in parallel is known as 
parallel processing. 

	 (iv) 	� Since the execution takes place in parallel, this 
feature is used for high speed execution which 
increases the power of computing.

27.	 Normal view is the main view for creating individual 
slides.

	 (i) 	� Use this view to format and design slides and 
to add text, graphics and animation effects.

	 (ii)	� There are two ways to place a slide in the Slide 
Design area of the Normal view: clicking the 
slide thumbnail in the Slides pane or using the 
Navigator.

28.	 The main advantages of email are listed below :
	 (i)	� Free delivery : Sending an e-mail is virtually 

free, outside the cost of Internet service. There 
is no need to buy a postage stamp to send a 
letter.

	 (ii)	� Global delivery : E-mail can be sent to nearly 
anywhere around the world, to any country.

	 (iii) 	� Instant delivery : An e-mail can be instantly sent 
and received by the recipient over the Internet.

	 (iv)	� File attachment : An e-mail can include one 
or more file attachments, allowing a person to 
send documents, pictures, or other files with 
an e-mail.

	 (v)	� Long-term storage : E-mails are stored 
electronically, which allows for storage and 
archival over long periods of time.

	 (vi) 	� Environment friendly : Sending an e-mail 
does not require paper ( Paperless), cardboard, 
or packing tape, conserving paper resources.

29.	 The <hr>tag having four attributes viz., size, width, 
noshade and color. These attributes are used to set 
size, width, 3D appearance and color to the horizontal 
line respectively.

	 The general syntax of <hr> tag with attributes:
	 <hr size = value width=value noshade, color = 
� color_name/code>
	 (i) 	� Size: Thickness of the horizontal line can be 

changed with size attribute.
	 (ii) 	� Width: The width attribute specifies the horizontal 

width of the line
	 (iii) 	� Noshade: The default view of a horizontal rule 

line is 3D. So, no need to specify the term 
“noshade” as an attribute with <hr> tag. If you 
specify the attribute “noshade” turn off 3D view, 
turns on 2D view.  

	 (iv)	� The color attribute is used to change the default 
color to desired color.

https://t.me/suraguides https://bit.ly/3pspUm0

enquiry@surabooks.com Ph:8124201000 / 8124301000 

www.su
ra

bo
ok

s.c
om

www.Padasalai.Net                                                          www.CBSEtips.in

Kindly send me your study materials to padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


4	 Sura’s  XI Std - Computer Applications ➠ Instant Supplementary Exam - July 2023 Question Paper with Answers

30.	

Value of type 
attribute Description

Text Create a Text Box. The element used to get all kind of text input such as name, address etc.,

Password Similar as Text box. But, while entering data, the characters are appearing as coded symbols 
such as asterisk.

Checkbox
Multi select box

Check box is an element appearing like a small square box. When the user click on the square 
a tiny tick mark will appear inside the square.  This element is used to select multiple options.

Radio 
Button

Radio button is used to select any one of the multiple options from the list.  This element 
looks like a small circle, when the user select an item, a tiny dot will appear within the circle.  
If the user selects another option, previously selected option will be deselected. This means, 
user can select any one of the given option form a group.

Reset It is a special command button used to clear all the entries made in the form.

Submit It is also a special command button used to submit all the entries made in the form to the 
backend server.

Button This is a standard graphical button on the form used to call functions on click.

33.	 Indent is the distance from the left and right margin of 
a paragraph. It is used to improve the efficiency and 
readability of the paragraph and makes the paragraph 
look more attractive.

	 There are four types of indents: 
(i) 	 Left Indent		    (ii)   Right Indent
(iii) First Line Indent and  (iv)  Hanging Indent. 

	 (i)	� Left indent : The Left indent controls the space 
between the paragraph and the left margin. This 
is the default indent.  Each click on the Increase 
indent icon moves the paragraph ½ inch away 
from the left margin

	 (ii)	� Right indent : The Right indent controls the 
space between the paragraph and the right margin.  
Each click on the decrease indent icon removes 
the indent applied by the increase indent. 

	 (iii)	� First line indent : A first-line indentation indents 
the first line of the paragraph. It is the most 
common way to start a new paragraph. This 
indent can be applied by Format → Paragraph → 
Indents and spacing tab, select first line option 
in the indent group, enter a positive value which 
results in first line indent.

	 (iv)	� Hanging indent : This is a special kind of indent 
where the first line of the paragraph alone hangs 
outside leaving the rest of the text. To apply 
hanging indent, a negative  value is given in 
the “first line” option of the paragraph dialog 
box.

31.	 The basic data types in JavaScript are Strings, Numbers, 
and Booleans.

	 (i)	� A string is a list of characters, and a string 
literal is indicated by enclosing the characters in 
single or double quotes. Strings may contain a 
single character or multiple characters, including 
whitespace and special characters such as \n 
(the newline).

	 (ii)	�N umbers can be integer or floating-point numerical 
value and numeric literals are specified in the 
natural way.

	 (iii)	� Boolean can be any one of two values: true or 
false. Boolean literals are indicated by using 
true or false directly in the source code.

32. 	
While Statements Do while Statements

1.	First condition will be 
evaluated and they only 
based on the result of the 
condition the body of the 
loop will be executed or not. 

do.... while loop body 
of the loop always 
executed atleast once 
before the condition can 
be execued. 

2.	Entry check loop. Exit check loop.

3.	Checking and execution 
time of loop is differ in while 
loop. 

Checking and execution 
time of loop is same in 
do while loop.
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Part - IV

34.	 (a)
(i)	 Inkjet Printers:
®	 Inkjet Printers use colour cartridges which  

combined Magenta, Yellow and Cyan inks to 
create color tones. A black cartridge is also used 
for monochrome output. Inkjet printers work by 
spraying jonised ink at a sheet of paper.  

® 	 They use the technology of firing ink by heating 
it so that it explodes towards the paper in bubbles 
or by using piezoelectricity in which tiny electric 
currents controlled by electronic circuits are used 
inside the printer to spread ink in jet speed. 

® 	 An Inkjet printer can spread millions of dots of ink 
at the paper every single second.

(ii)	M ultimedia Projectors:
®	 Multimedia projectors are used to produce computer 

output on a big screen. 
® 	 These are used to display presentations in meeting 

halls or in classrooms.

(iii)	 Bar Code / QR Code Reader: 
®	 A Bar code is a pattern printed in lines of different 

thickness. The Bar code reader scans the information 
on the bar codes transmits to the Computer for 
further processing. 

® 	 The system gives fast and error free entry of 
information into the computer.

QR (Quick response) Code: 
The QR code is the two dimension bar code which 
can be read by a camera and processed to interpret 
the image.

(OR)

(b)	� A Microprocessor’s performance depends on the 
following characteristics: 
(a)	 Clock speed
(b)	 Instruction set
(c)	 Word size

(a)	 Clock Speed :
(i)	� Every microprocessor has an internal 

clock that regulates the speed at which it 
executes instructions. 

(ii) 	� The speed at which the microprocessor 
executes instructions is called clock 
speed. Clock speed is measured in MHz 
(Mega Hertz) or in GHz (Giga Hertz). 

(b)	 Instruction set :
(i) 	� A command which is given to a computer 

to perform an operation on  data is called 
an instruction. 

(ii)	� Basic set of machine level instructions 
that a microprocessor is designed to 
execute is called as an instruction set. This 
instruction set carries out the following 
types of operations:
�� Data transfer
�� Arithmetic operations
�� Logical operations
�� Control flow
�� Input/output 

(c)	 Word Size :
(i)	� The number of bits that can be processed 

by a processor in a single instruction is 
called its word size. 

(ii) 	� Word size determines the amount of RAM 
that can be accessed by  a microprocessor.

35.	 (a)	 OpenOffice Writer has a Find and Replace feature 
that helps to locate for a text inside a document 
and replace it with another word.

®	 Click Edit → Find & Replace (or) Ctrl + F
®	 The Find & Replace dialog box appears as 

shown.
Steps to Find & Replace a text :
(i)	 Type the text you want to find in the Search for box
	 For Example : To search a word “Bombay” in a 

document and replace with “Mumbai”, enter the 
word “Bombay” in the Search for box.

(ii) 	 Enter the word “ Mumbai” in the Replace with 
box and Click Find button, to start the search, the 
found word is highlighted and the first occurrence 
of “Bombay” is highlighted.

(iii)	 To replace text, click Replace button.

	� The highlighted word is replaced with the word 
given in the Replace with box.
(iv)	 Click Find All, Writer selects all instances of the 

search text in the document.
	 All occurrences of Bombay are highlighted.
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(v)	 Click Replace All button, Writer replaces all 
matches.

	� This will replace all occurrences of “Bombay” 
with “Mumbai”.

(vi)	 Enable Match case to perform the search case 
sensitively so that uppercase and lower cases 
are distinguished separately.

(vii)	 Enable Whole Words only to make the search more 
specific to words. For example, if you search for 
the word “Image”, the command will only find 
“Image” not “Imaging”, “Images” etc.

Find & Replace dialog box

(OR)
(b)	 (i)	  Convert (58.36)10 to Binary.

I.	 Integer part:

	      

2

2
2

2
2
2

58

29  – 0
14  – 1

7    – 0
3    – 1
1    – 1

II.	 Fractional part:
0.36 × 2  = 0.72 = 0
0.72 × 2  = 1.44 = 1
(58.36)10 = (111010.01...)2

(ii)	 1’s complement of (–55)10

	        

2

2
2

2
2

55

27  – 1
13  – 1

6    – 1
3    – 0
1    – 1

		  (55)10 = 110111

		  8 bit format of 5510  =    00110111

	 1’s complement	 =    11001000
	 Add 1 bit		  = 	  +   1

	 2’s complement 	 =    11001001

36.	 (a)	 JavaScript supports three important types of dialog 
boxes. Dialog boxes are also called as Popup 
Boxes. These dialog boxes can be used to raise an 
alert, or to get confirmation on any input or to have 
a kind of input from the users. JavaScript supports 
three kind of popup boxes: Alert box, Confirm 
box, and Prompt box.

Alert Dialog Box : An alert dialog box is mostly 
used to give a warning message to the users. For 
example, if one input field requires to enter some 
text but the user does not provide any input, then 
as a part of validation, you can use an alert box to 
give a warning message. Alert box gives only one 
button “OK” to select and proceed.
The syntax of alert box is
Alert(“Message”);
(or) Window.alert (“Message”);
Example :
alert(“Name is compulsory entry”);
(or) window.alert(“Name is compulsory entry”);
�Confirm Dialog Box : A confirmation dialog box 
is mostly used to take user’s consent on any option. 
It displays a dialog box with two buttons: OK and 
Cancel. If the user clicks on the OK button, the 
confirm() will return true. If the user clicks on the 
Cancel button, then confirm() returns false.
The syntax of confirm dialog box is
	 confirm(“message”);
			   (or)
	 window.confirm(“message”);
Example :
	 confirm(“Hai Do you want to continue:”);
			   (or)
window.confirm(“Hai Do you want to continue:”);
�Prompt Dialog Box : The prompt dialog box is 
very useful when the user want to pop-up a text 
box to get user input. Thus, it enables you to 

https://t.me/suraguides https://bit.ly/3pspUm0

enquiry@surabooks.com Ph:8124201000 / 8124301000 

www.su
ra

bo
ok

s.c
om

www.Padasalai.Net                                                          www.CBSEtips.in

Kindly send me your study materials to padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


Sura’s  XI Std - Computer Applications ➠ Instant Supplementary Exam - July 2023 Question Paper with Answers� 7

interact with the user. The user needs to fill in the 
text box field and then click OK.
�The prompt dialog box is displayed using a method 
called prompt() which takes two parameters : 
�(i) a label which you want to display in the text box 
and (ii) a default string to display in the text box. 
This dialog box has two buttons: OK and Cancel. 
If the user clicks the OK button, the prompt() will 
return the entered value from the text box. If the 
user clicks the Cancel button, the prompt() returns 
null. The Syntax of prompt dialog box is,
	 Prompt(“Message”,”defaultValue”);
			   (or)
� window.prompt(“sometext”,”defaultText”);
Example :
	 prompt(“Enter Your Name:”,”Name”);
			   (or)
window.prompt(“Enter Your Name:”,”Name”);

(OR)

(b)	 �Rules for naming variable : 
(i)	 The first character must be a letter or an underscore 

(_). Number cannot be as the first character.
(ii)	 The rest of the variable name can include any letter, 

any number, or the underscore. You can’t use any 
other characters, including spaces, symbols, and 
punctuation marks.

(iii)	 JavaScript variable names are case sensitive. That 
is, a variable named Register Number is treated 
as an entirely different variable than one named 
register number.

(iv)	 There is no limit to the length of the variable name.
(v)	 JavaScript’s reserved words cannot be used as a 

variable name. All programming languages have 
a supply of words that are used internally by the 
language and that cannot be used for variable names.

37.	 (a)	 Step to generate the series  5, 10, 20..2560 

Step 1 : �Select the required number of cells to generate 
the series.

Step 2 : �Click EDIT → FILL, the Fill Series dialog 
box appear.

Step 3 : �Select Direction Down in fill series dialog 
box.

Step 4 : Select the Series type growth.

Step 5 : �Initial value of the series 5 should be typed in 
start value box.

Step 6 : �Maximum value of the series 2560 should be 
typed in End value box.

Step 7 : �The value 2 should be typed in Increment 
box.

Step 8 : �Click Ok.
(OR)

(b)	 �Filtering : Filter is a way of limiting the information 
that appears on screen. The visible records satisfy 
the condition that the user sets. Those that do not 
satisfy the condition are hidden, but not removed. 
OpenOffice Calc allows three types of filters. They 
are AutoFilter, Standard Filter and Advanced Filter.

	� Auto Filter: Auto Filter applies a drop-down list 
box to each field (columns) filled with similar data 
available in that field. Using the list box item, you 
can filter the data that matches the criteria of the data 
concerned.

	� Using Auto Filter:  Click Auto Filter icon available 
on the “Standard tool bar” (or) Click Data → Filter 
→ Auto Filter • The list box contains similar data in 
the fields. Each list box item will be considered as 
filter criteria.

	� Removing Auto Filter:  To remove auto filter, click 
“Auto filter” icon once again . The original table is 
displayed without filter. Standard Filter: Auto filter 
is used only for single criteria on a data, whereas the 
Standard filter is used for multiple critieria to filter.

	� Standard Filter:  Auto filter is used only for single 
criteria on a data, where as the standard filter is used 
for multiple criteria to filter.

38.	 (a)	 Page margins are the white space around the top, 
bottom, left and right of your document.

Changing or setting page margins in openoffice writer 
can be done in two ways: 
(i)	� Using the Rulers - quick and easy, but does not have 

precise values. 
(ii)	� Using the Page Style dialog box - can specify precise 

values for the margins.  
Changing Page Margins using Ruler:
(i)	� The shaded sections of the rulers are the margins. 
(ii)	� Hold the mouse pointer over the line between the 

gray and white sections.
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(iii)	� The mouse pointer turns into a double-headed arrow.
(iv)	� Hold down the left mouse button and drag the mouse to move the margin and release it at the required point.
(v)	 The new margin is set.
Using the Page Style Dialog Box:
To change margins using the Page Style dialog box  
(i)	� Right-click anywhere on the page and select Page from the popup menu or select page tab of page style dialog 

box.
(ii)	� In the Margins boxes, specify the values for left, right, top and bottom margins.
(iii)	 Click on OK button. 

(OR)

(b)	

Cyber Attack Function

Virus

A virus is a small piece of computer code that can repeat itself and spreads from one computer 
to another by attaching itself to another computer file. One of the most common virus is Trojan.

Trojan :
A Trojan virus is a program that appears to perform one function (for example, virus removal) 
but actually performs malicious activity when executed.

Worms
Worms are self- repeating and do not require a computer program to attach themselves. Worms 
continually look for vulnerabilities and report back to the author of the worm when weaknesses 
are discovered.

Spyware Spyware can be installed on the computer automatically when the attachments are open, by 
clicking on links or by downloading infected software.

Ransomware
Ransomware is a type of malicious program that demands payment after launching a cyber-
attack on a computer system. This type of malware has become increasingly popular among 
criminals and costs the organizations millions each year.



https://t.me/suraguides https://bit.ly/3pspUm0

enquiry@surabooks.com Ph:8124201000 / 8124301000 

www.su
ra

bo
ok

s.c
om

www.Padasalai.Net                                                          www.CBSEtips.in

Kindly send me your study materials to padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/



